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Analysis of Variance



Introduction

Goal: To test the hypothesis

H0 : µ1 = µ2 = . . . = µk

where k is the number of independent populations

We can do all the possible tests in pairs.
In this case, the probability of Type I Error increases, i.e. the possibility
to obtain statistically significant differences when in fact there are not.

For example if k = 10, there are 45 possible pairs for testing. By using
α = 5% in each of these tests, 0.05× 45 ≈ 2 tests may give us
statistically significant differences in means completely at random.

I Thus, a new methodology is required.



One-way ANOVA

H0 : µ1 = µ2 = · · · = µk vs H1 : at least one µi differs

I Yij i-th observation that belongs to j-th group, i = 1, . . . , nj and j = 1, . . . , k

I Y·j =

nj∑
i=1

Yij the sum of observations of the j-th group.

I Y ·j =
1

nj

nj∑
i=1

Yij sample mean of j-th group

I Y·· =
k∑

j=1

nj∑
i=1

Yij the sum of all the observations

I Y ·· =
1

n

k∑
j=1

nj∑
i=1

Yij the sample mean, where n =
∑k

j=1 nj



One-way ANOVA

Two sources of variability in the data:

I variation among observations within a population

I variation among populations that is due to the differences in the
characteristics of the population,

Part of the goal of the analysis of variance is to determine if the
differences among the k sample means are what we would expect due to
random variation alone or, rather, due to variation beyond merely random
effects.

I Assumptions
The k populations are independent and normally distributed with means
µ1, . . . , µk and common variance σ2



One-way ANOVA

yij − y ·· = yij − y ·j + y ·j − y ··

I yij − y ·j variability within group
I y ·j − y ·· variability between groups .

I If the variability between groups is large and the variability within groups is small,
the null hypothesis must be rejected.
I If the variability between groups is small and the variability within groups is large,
the null hypothesis must not be rejected.

k∑
j=1

nj∑
i=1

(yij − y)2 =
k∑

j=1

nj∑
i=1

(yij − y ·j )
2 +

k∑
j=1

nj (y ·j − y ··)
2

where
I SST Total Sum of Squares
I SSW Sum of Squares Within group
I SSB Sum of Squares Between groups

MSW =
SSW

n − k
, MSB =

SSB

k − 1
,

F =
MSB

MSW
∼ Fk−1,n−k

Thus, at α% significance level, the hull hypothesis is rejected if F > Fk−1,n−k·a.



One-way ANOVA

Variability Degrees of Freedom Sum of Squares Mean Square

Between groups k − 1
k∑

j=1

nj (y ·j − y ··)
2 = SSB

SSB

k − 1
= MSB

Within groups n − k
k∑

j=1

nj∑
i=1

(yij − y ·j )
2 = SSW

SSW

n − k
= MSW

Total n − 1
k∑

j=1

nj∑
i=1

(yij − y ··)
2 = SST

SST

n − 1
= MST

F =
MSB

MSW
∼ Fk−1,n−k

Reject H0 when F > Fk−1,n−k,a.



One-way ANOVA

I Homoscedasticity. Levene’s test is applied for testing the equality of
variances in the k populations which is a generalization of the standard
F-test for testing the equality of variances in two populations.

I When the above assumptions are not valid, either the response variable
is transformed, or the corresponding nonparametric test, named Kruskal
Wallis test is applied.

I If H0 is rejected, i.e. if it is assumed that there is a statistically
significant difference between three or more groups, then it is important
to find between which groups there is difference.

I Bonferroni’s method. N tests are applied and the p−value is
readjusted to p′ = N p with the assumption that p′ ≤ 1.



One-way ANOVA

22 patients who underwent heart surgery were divided into three groups.

I Group 1. Patients who were treated with a mixture of 50% nitrous oxide and 50% oxygen for 24
hours.
I Group 2. Patients who were treated with a mixture of 50% nitrous oxide and 50% oxygen Only
during surgery.
I Group 3. Patients who were treated with a mixture of 35− 50% nitrous oxide and 50% oxygen
for 24 hours.

In the following table the value of folic acid mg/l in erythrocytes of patients is presented.

Patients Group 1 Group 2 Group 3
1 243 206 241
2 251 210 258
3 275 226 270
4 291 249 293
5 347 255 328
6 354 273
7 380 285
8 392 295
9 309

Do the patients of the three groups have the same mean level of folic acid mg/l in their

erythrocytes?



One-way ANOVA in SpSS

Analyze > Compare Means > One-Way ANOVA...



One-way ANOVA in SpSS

Post Hoc...



One-way ANOVA in SpSS

Options...



One-way ANOVA in SpSS
Output



Chi-Square test



Goodness-of-fit test
I a test to determine if a population has a specified theoretical
distribution.
I H0 : The population has a specified theoretical distribution vs
I H1 : The population has NOT the specified theoretical distribution

I The test is based on how good is the obtained fit between the
frequency of occurrence of observations in an observed sample and the
expected frequencies obtained from the hypothesized distribution.

I For example, we consider the tossing of a die. We hypothesize that the
die is honest.

H0 : f (x) = 1
6 , x = 1, . . . , 6 vs H1 : not H0 :

The die is tossed 120 times and each outcome is recorded

x 1 2 3 4 5 6
observed 18 22 30 21 17 12
expected 20 20 20 20 20 20

Test at a 5% significant level if the dice is unbiased.



Goodness-of-fit test

I The observed frequencies Oi

I Compute the expected frequencies under the null hypothesis.
IEi = npi
I I n : the sample size
I I pi : the probability of the value xi .
I Compute the quantity

X 2 =
k∑

i=1

(Oi − Ei )
2

Ei
∼ X 2

k−1 under H0

I If X 2 > X 2
k−1·α, then H0 is rejected at α% significant level.

I The decision criterion described here should not be used unless each of
the expected frequencies is greater or equal to 5.

I χ2 = (20−20)2

20
+ (22−20)2

20
+ (17−20)2

20
+ (18−20)2

20
+ (19−20)2

20
+ (24−20)2

20
= 1.7

I χ2
5,0.05 = 11.07



Goodness-of-fit test

I Example
The level of noise in a village near to a racetrack is rated during a race at
a scale of 1-5 from all adult residents of the population. The results of
the responses of the people presented in the following table.

Noise Level 1 2 3 4 5
Frequencies 90 88 85 104 128

At α = 5% significance level, test if there is a difference between the
percentage of responses of residents about how they experience the noise
level.



Goodness-of-fit test



Goodness-of-fit test

Data > Weight Cases...



Goodness-of-fit test

Analyze > Nonparametric Tests > Legacy Dialogs >

Chis-square...



Goodness-of-fit test



Goodness-of-fit test

I Example
The Weibull distribution with cumulative distribution function (cdf)

F (t) = 1 − e−(t/β)α , t > 0

contains as a spacial case for α = 2 the Rayleigh distribution which is used to describe
the error in the determination of the location of an item by its programmer. When the
errors are analyzed in rectangular coordinate systems, they are described by two
independent normal distributions with mean 0 and common standard deviation. A
company that produces positioning devices, argues that the determination error (in
meters) of the location that a new device presents when used in open area follows the
Rayleigh distribution and at 50% of cases, the error is less than 0.832555 meters.
The following table presents the measurements of determination error (in meters) of
the location in a random sample of 66 selected users of the new device.

Determining error <0.3 0.3-0.5 0.5-0.7 0.7-0.9 0.9-1.1 >1.1

Frequencies 6 8 11 12 10 19

Based on the above data, check the validity of the company’s claim.



Goodness-of-fit test



Goodness-of-fit test

I When the X 2 test is applied to continuous variables, it is influenced by the
grouping of the data. So, X 2 goodness of fit test is preferred when we have
categorical variables with finite state space.

In SpSS, we cannot apply X 2 goodness of fit test to continuous variables.
In cases where continuous data is available, Kolmogorov - Smirnov test is
preferable where it is based on the empirical cumulative distribution function.

I The X 2 test can be applied even when the parameters of the population
distribution are unknown. In this case the degrees of freedom of the statistical
test are reduced according to the number of parameters under estimation.
The unknown parameters of the distribution are estimated by the observations
and in this case the test statistic has the following form

X 2 =
k∑

i=1

(Oi − Êi )
2

Êi

∼ X 2
k−1−r

and H0 is rejected when X 2 > Xk−1−r,α



Kolmogorov - Smirnov test

Empirical cumulative distribution function
Let x1, x2, . . . , xn be a random sample.

Fn(x) =

n∑
i=1

I (xi ≤ x)

n

If the sample is derived from the assumed distribution then the empirical
cumulative distribution function should not differ significantly from the
theoretical cdf.

It holds
P( lim

n→∞
|Fn(x)− F (x)| = 0) = 1, ∀x

Kolmogorov - Smirnov test is based on the observed differences of Fn(x)
and F (x).



Kolmogorov - Smirnov test

D+
n = sup{Fn(x)− F (x)}

D−n = sup{F (x)− Fn(x)}

The test statistic is

D = sup{|Fn(x)− F (x)|}
= max{D+

n ,D
−
n }

It is based on the maximum observed difference of the theoretical and the
empirical cdf.



Kolmogorov - Smirnov test

Under H0, it holds

P(
√
n D < d) = 1− 2

∞∑
i=1

(−1)k−1e−2k2/d2

, 0 ≤ d ≤ 1

This is true for any theoretical distribution assumed.

H0 is rejected at significance level a if D > Dn,a where Dn,a the value of the
corresponding table.

I Kolmogorov - Smirnov test requires the theoretical distribution under the
null hypothesis to be fully determined.

I If the theoretical distribution is not known, its parameters are estimated by
the data. But in this case there are no tables to give the critical values so
simulations are needed to identify them.

Example:

Test if the observations given in the file KS1.sav come from the normal

distribution.



Test of independence
The chi-square test can also be used to test the hypothesis of independence of
two variables of classification.

H0 The variables A and B are independent
H1 The variables A and B are dependent

B1 B1 · · · Bc

A1 O11 O12 · · · O1c

A2 O21 O22 · · · O2c

...
...

...
...

...
Ar Or1 Or2 · · · Orc

H0 The probability in the cell (i , j) is equal to the product of the probabilities
to be in the group i of the variable A and in group j of the variable B

pij = pi· · p·j ∀i , j

H1 Not H0 i.e. pij 6= pi· · p·j , for at least one (i , j).

X 2 =
r∑

i=1

c∑
j=1

(Oij − Eij)
2

Eij
∼ X 2

(r−1)(c−1)

B1 B1 · · · Bc

A1 O11 O12 · · · O1c

A2 O21 O22 · · · O2c

...
...

...
...

...
Ar Or1 Or2 · · · Orc



Test of independence

Example:

The aeronautical aluminum alloy 2024-73 and 2024-74 are often used in
the fuselage and wings of the aircraft. During the repair of 250 damages
in the fuselage and the wings of aircraft (a) the type of aluminum alloy
used to manufacture, and (b) the type of failure were recorded.

failure
Alloy fatigue corrosion crash

2024 - 73 47 76 27
2024 - 74 41 42 17

Is the type of failure independent of the type of alloy?



Test of Homogeneity

I It can be used to test whether different populations have the same
percentage of people with the same characteristic

I r ≥ 2 populations are divided into c ≥ 2 groups based on some
characteristic and examine if the rate of each group is the same across all
populations.

H0 The percentage of each group is the same across all populations

H1 The percentage of at least one group is not the same across all
populations



Test of Homogeneity

Example:

A telecommunication company has 5 factories that operate with the same
specifications. In order to check the company if there is not any difference in
the offered quality between the factories, it got a sample of phones
manufactured and submitted to check in order to see how many of them are
defective. The collected data are shown in the table below.

Factory defective, not defective

A 20 80
B 7 153
C 8 152
D 6 74
E 19 201

Test if the percentage of defective telephones is the same across the five
factories.



Test for several proportions

The chi-square statistic for testing homogeneity is also applicable for
testing the hypothesis that k binomial parameters have the same value
H0 : p1 = p2 = · · · = pk

Samples 1 2 . . . k
successes x1 x2 . . . xk
failures n1 − x1 n2 − x2 . . . nk − xk

I Compute the quantity

X 2 =
∑
i

(oi − ei )
2

ei
∼ X 2

k−1 under H0

I If X 2 > X 2
k−1·α, then H0 is rejected at α% significance level.



Nonparametric Tests



Sign Test
I H0 : δX − δY = 0 vs H1 : δX − δY 6= 0
Test the equality of the medians of two continuous dependent random variables
X and Y (paired samples)

Or equivalent

H0 p = 0.5 vs H1 p 6= 0.5

where p = P(X > Y ).
Let

n+ =
n∑

i=1

I (xi > yi ), n− =
n∑

i=1

I (xi < yi )

R = max{n+, n−}

Under H0, R ∼ B(n, 0.5) thus E(R) = n/2 Var(R) = n/4.
The probability P(R ≥ r) can be computed.

If n is large then under H0, R ∼ N (n/2, n/4)
In this case, the test statistic is

R − n/2− 0.5√
n/4

∼ N (0.1)



Wilcoxon signed-rank test

I H0 : δX − δY = 0 vs H1 : δX − δY 6= 0

Wilcoxon signed-rank test step by step:
1. Compute the ranks of the absolute differences |xi − yi | ignoring the cases
where xi − yi = 0.
2. Compute the sums of the ranks Sp and Sn that correspond to positive and
negative differences respectively.
3. If the sample size n is large, then

Z =
min{Sn, Sp} − n(n+1)

4√√√√ n(n+1)(2n+1)
24

−
L∑

i=1

t3
i − ti

48

∼ N(0.1)

under H0.

L the number of cases that we have equal observations and ti the number of

observations with the same rank.



Wilcoxon signed-rank test

I H0 : δX − δY = 0 vs H1 : δX − δY 6= 0

Wilcoxon signed-rank test step by step:
1. Compute the ranks of the absolute differences |xi − yi | ignoring the cases
where xi − yi = 0.
2. Compute the sums of the ranks Sp and Sn that correspond to positive and
negative differences respectively.
3. If the sample size n is large, then

Z =
min{Sn, Sp} − n(n+1)

4√√√√ n(n+1)(2n+1)
24

−
L∑

i=1

t3
i − ti

48

∼ N(0.1)

under H0.

L the number of cases that we have equal observations and ti the number of

observations with the same rank.



Wilcoxon signed-rank test

Example

To evaluate the results of the retraining seminar in engineers, 35
engineers were randomly selected and asked to answer a series of
questions before and a month after the seminar. The scores are presented
in the file entitled seminar.sav.

Test if there is a difference in the median performance of engineers before
and after participation in the seminar.



Kruskal–Wallis Test
I H0 : δX1 = δX2 = · · · = δXk and H1 not H0

Kruskal–Wallis Test step by step
1. Compute the ranks of the observations assuming the k samples as one.
2. Compute the sums of the ranks Ri , the number of observations ni in each
group and the quantity Ti = t3

i − ti in cases where they are observations with
the same rank where ti is the number of observations with the same rank.
3. If ni ’s are large, i.e. ni > 5.

H =
12

N(N + 1)

k∑
i=1

R2
i

ni
− 3(N + 1) ∼ X 2

k−1

under H0.
In the case that they are observations with the same rank, the above quantity
is corrected as follows

H ′ =
H

1−
L∑

i=1

t2
i (ti − 1)

N2(N − 1)

where L is the number of cases that we have equal observations.



Kruskal–Wallis Test

Example:
The file tires.sav displays the results of laboratory measurements of
the tread wear indicator (TWI) presenting the tires of three different
companies when used under the same conditions.

Test, at a significance level of 5%, if there are differences between the
tires of the three companies.



Run Test

I Randomness test

H0 The sample is random H1 The sample is not random

The random variable is of the form {0, 1}
− defective or not defective product.
− component type A or Type B
− a characteristic above or bellow a value

If the population is expressed by a binary variable then the sample is a run
sequence.

Definition: In a symbol sequence of at least two types of symbols, run is called
a sequence of the same symbol which is blocked by symbols of other type. The
number of symbols of the run is called the length of the run.

If the random variable is continuous then the sample is a device of real numbers, but
it can be converted to a run sequence.

A symbol is associated with each sample depending on whether or not it is greater

than the median or the mean. Price equal to the median or the average is omitted.



Run Test

0, 0, 0, 1, 0, 1, 1, 0, . . .
H0 The sample is random H1 The sample is not random

If the sample is not random then there are trends expressed with symbol
accumulations and either the number of runs is small but their length is large, or there
are symbol recycling expressed by systematic variations of symbols and the number of
runs is very large.

So according to the above we reject the null hypothesis, if the number of runs is very
small or very large.

I Let R0 and R1 the number of 0 and 1 runs and n0 and n1 the number of the
corresponding symbols in the sample.

H0 is rejected at significance level α% if

P(R ≤ k1) = α/2 or P(R ≥ k2) = α/2

where R = R0 + R1,

k1 and k2 the corresponding values in the tables of this test.

µR = E(R) =
2n0n1

n0 + n1
+ 1

σ2
R = Var(R) =

2n0n1(2n0n2 − n0 − n2)

(n0 + n1)2(n0 + n2 − 1)

Z =
R − µR

σR
∼ N(0, 1)



Run Test

I Example.
During a laboratory experiment, the friction coefficient between two
metals was measured. The results are presented in the following table.

0.59 0.61 0.56 0.58 0.60 0.52 0.54
0.53 0.51 0.62 0.58 0.61 0.57 0.56
0.63 0.62 0.55 0.51 0.50 0.61 0.57
0.55 0.53 0.49 0.62 0.63 0.60 0.53

The head of the laboratory suspects that measurements shots were not
correct and therefore wants to examine whether the measures can be
considered random or not. With the help of the median, test if there are
significant indications at significance levels a = 0.05% that the
measurements can not be considered random.


	Analysis of Variance - ANOVA
	One-way ANOVA 

	Chi-Square tests 
	Goodness-of-fit test 
	Test of independence 
	Test of Homogeneity 
	Test for several proportions 

	Nonparametric Tests
	Sign Test 
	Wilcoxon signed-rank test 
	Kruskal–Wallis Test 
	Run Test 


